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Introduction to IDrive 
 
Virus attack, hard drive crash, natural disaster, human error or theft etc. could cause you to lose 
important files, business documents, photos, emails, music, videos etc. 
 
IDrive online backup is designed to protect you against any data catastrophe. It automatically 
secures your critical data in a matter of two clicks*. Critical folders like Documents, Desktop, 
Music, Pictures and Videos are pre-selected for backup at a random after-hours backup 
schedule. Customization options include the provision to modify your Backup set, its schedules, 
reporting options and more.  
 
Your files and folders are transferred between the application and server using 128-bit SSL 
encryption and stored at our world-class data centers with 256-AES military grade encryption. 
The encryption key is used to encrypt and decrypt your data, ensuring that no one but you have 
access to it. 
 
All backed up files can be viewed, managed and restored on the move, via the web. 
 
Our online backup and storage solution is ideal for individuals and small businesses with large 
backup needs. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
* This assuming you accept the defaults. 
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IDrive Features 
 
Basic Features 
 
Simple interface - makes backup and restore simple 
 
Data compression and incremental backups - only modified portions of the file are backed up 
(after full initial backup) to ensure optimal bandwidth usage and fast backups 
 
Bandwidth Throttle - set the Internet bandwidth usage for the IDrive application to allow other 
web-based applications to run smoothly 
 
Continuous Data Protection - only modified portions of files and folders are automatically 
backed up in real-time, offering you hands-free data protection 
 
Proxy/firewall friendly - works behind most firewalls and proxy servers 
 
Compatibility - works on most Windows Operating Systems 
 
Advanced Features 
 
Mapped drive backup - even if the computer is in the 'Log-Off' state 
 
Reliable open/locked file backup - like Outlook files (.pst), QuickBooks, MS-Excel and so on 
 
Backup multiple PCs (up to five computers) in parallel to a single account 
 
True Archiving / Sync -data is not removed from your account until you manually delete it or run 
sync to match your desktop data to your account. You control your backup data 
 
File Versioning - retrieve any of the previous 30 versions of a file (that was backed up to your 
account) to your local machine 
 
Timeline Restore - view and restore data as of a particular timeline to your local machine 
 
Automatic power-off after the scheduled backup - on selecting this option, your computer will 
shut down on completion of the scheduled backup 
 
Start missed schedule backup - on selecting this option, the scheduled backup is resumed at 
the next frequency, if your computer has been shut down for more than 30 minutes from the 
scheduled backup time 
 
24 X 7 access - connect via any web browser to your account and access backed up data, log 
reports and restore files to your local machine 
 
View Logs - of backup and restore operations and details of files / folders deleted from your 
account, from any browser. 
 
Restore files - to any computer, without installing the application 
 
Create and manage multiple accounts - and group them for easy management 
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Search - locate files/folders backed up to your online account 
 
Security Features  
 
Encryption 
All your data is secured using 128-bit SSL encryption during transmission and 256-bit AES 
encryption on storage. 
 
IDrive enforces a user-defined encryption key that is known only to you. Not even IDrive 
personnel have access to it, thereby making your data secure. However, if you opt for the default 
encryption, the application provides the key, without the need for you to remember the same. 
 

 
 
All your data resides on raid-protected devices for additional protection and for fast recovery in 
case of hardware/software failures. 
 
Physical Security 
The IDrive application is hosted at world-class Internet data centers at California, which provide 
the physical environment necessary to keep the servers up and running 24X7. These world-class 
facilities are custom designed with raised floors, HVAC temperature control systems with 
separate cooling zones and seismically braced racks.  
 
They offer the widest range of physical security features, including state-of-the-art smoke 
detection and fire suppression systems, motion sensors, and round-the-clock secured access, as 
well as video camera surveillance and security breach alarms. 
 
Network Security 
We have a periodic third party audit of our network infrastructure to check for known application 
and service vulnerabilities. 
 
 
Backup of backups 
User data resides on raid protected industry leading storage devices with multiple levels of 
redundancy. In addition, data is periodically backed up onto another set of devices for additional 
security. 
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System Requirements  
 
• Microsoft Windows 7, Windows Server 2008, Windows Vista, Windows Home Server, 

Windows Server 2003, Windows XP Home/Professional, Windows 2000 Advanced Server, 
Microsoft Windows 2000 (Service pack 4) (Administrator privileges to install and use the 
application). 

• Internet Explorer 6 or later. 
• 512 MB RAM, 10 MB Free Hard Disk space for installed program, 20 MB or more 

recommended for local caching. 
 

Download IDrive  
 
Steps to download the application: 
 
1. Go to http://www.idrive.com/online-backup-download.htm. 
2. Click Download.  
3. Click Save to save the setup file to your local system.  

http://www.idrive.com/online-backup-download.htm


 

Copyright © Pro Softnet Corporation. All Rights Reserved.                                                                                                 7 

Install IDrive  
 
Steps to install the IDrive application: 
 
1. After downloading the application, double-click the IDriveSetup.exe. The ‘Install IDrive’ 

screen is displayed.  
2. Click Next to proceed with the installation. The ‘License agreement’ screen is displayed. Click 

the ‘I Agree’ button to proceed with the installation.  
3. In the ‘Where to Install?' screen, select the destination folder to which you want to install the 

application and click Next. A screen showing the installation progress is displayed. Click 
‘Finish‘ to complete the process.  

 
Login to IDrive  
 
You can login to the IDrive application in the following ways: 
 
• Double-click the IDrive icon on your Desktop. 
• From the Start menu, go to Programs > IDrive > IDrive Explorer or IDrive Classic for 

logging into IDrive Explorer and IDrive Classic respectively. 
• Right-click the IDrive Tray Icon on the system tray and select Login-IDrive Schedule Backup 

or Login - Open IDrive Explorer for logging into IDrive Classic or IDrive Explorer interface 
respectively. 

 

 
 
Enter the Username or Email address and Password and click the Connect button. 
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The Login screen has the following options: 
 
Reconnect automatically on Login: 
This option automatically connects the IDrive application to your account on subsequent logins or 
on restarting the computer. 
 
Remember Username/Password and other Settings:  
This option saves the Username and Password so that you do not have to type it on subsequent 
logins. 
 
Note: Above options are enabled by default. You can change them as per your convenience. 
 
New User Sign up  
This option allows you to sign up for an IDrive account. 
 
Forgot Password  
This option allows you to retrieve your password. It is sent to the email address provided by you 
during registration. 
 
Upgrade Account  
This option allows you to upgrade your IDrive account from the current storage limit to a higher 
storage limit. For details, visit our website http://www.idrive.com/pricing.htm. 
 
Firewall Guidance  
This option enables you to adjust the settings such that the IDrive application can work behind the 
firewall. 
 
Connect  
This button allows you to login to the IDrive application. 
 
Close  
This button closes the Login screen. 
 
Advanced  
This button allows you to manage the proxy settings for the application. 
 
Note: On logging into an IDrive account for the first time, you can opt for the default encryption key or set 
your own key. If you opt for default, then there is no need to remember it. However, if  you opt for your own 
encryption (private) key , then you have to remember and enter the encryption password to access your 
backed up data. 
 

http://www.idrive.com/pricing.htm
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IDrive Settings  
 
If you are behind a proxy server, enter the proxy details to login into IDrive. The application lets 
you set and change the proxy settings and enable the proxy authentication.  
 
Steps to update the proxy settings: 
 
1. Click the Advanced button on the ‘Login’ screen. The Proxy Settings screen is displayed. 
2. Change the settings and click Apply Proxy Settings to save the settings or click Reset to 

enter the settings afresh. 
 

 
 
There are two types of proxy settings, one for the Internet and the other for server authentication. 
 
Enable HTTP/Socks Proxy 
 
Select the Enable HTTP/Socks Proxy option to set the Proxy server for your computer. 
 
This enables the following options: 
• Enable HTTP Proxy 
• Enable Socks Proxy 
 
Select any option and enter the Proxy Address and its Port Number. 
 
If the Internet Explorer browser has proxy settings, use the Get IE Settings button to get the 
Proxy setting information and set this as default. 
 
Enable Proxy Authentication 
 
Select the check box for Enable Proxy Authentication to set the proxy server credentials and 
enter the Username and Password. 
 
Note:  The updates are reflected on subsequent login. 
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IDrive Classic Interface  
 
IDrive Classic’s interface is simple, making it easy for you to navigate through the application. On 
a first time login to an account in a computer, the following screen is displayed. 
 

 
 
By default, the IDrive application backs up the 'My Documents' and 'Desktop' folders, with the 
frequency set to a random off-peak hour. You can edit the 'Contents of my Backup set' and/or 
schedule the backup as per your convenience. 
 
For Windows Vista system, the 'Desktop', 'Documents', 'Pictures', 'Videos' and 'Music' folders are 
backed up by default, with the frequency set to a random off-peak hour.  
 
The screen has the following options:  
 
Edit my Backup set takes you to the IDrive classic main screen from where you can update the 
'Contents of my Backup set' and schedule backups. 
 
Edit Schedule Parameter opens the 'Scheduler' screen from where you can modify the 
scheduled backup options like day and time and set notification options and so on.  
 
Bandwidth Test lets you test the speed at which 1 GB of data can be backed up to or restored 
from your account.  
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The Close button closes the above screen and displays the main screen of the IDrive Classic 
application 
 
Classic Main Screen 
 
The IDrive Classic main screen is shown below: 
 

 
 
The IDrive Classic Main Screen has Backup and Restore tabs with the respective menu bar and 
toolbar options.  
 
The Backup tab helps set up data for scheduled or immediate backup while the Restore tab 
helps restore data to your local machine.  
 
The main screen can be categorized as follows: 
• Menu Options 
• Toolbar Options 
• Other Options 
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Menu Options 
 
The menu bar has the following options: 
 
File  
 
The File menu has options that let you select files for automatic backup, connect to or disconnect 
from the IDrive account and exit the application. These include: 
 
• Automatic Selection 
This option allows you to select your commonly used applications and file types for automatic 
backup.  

 

 
 
You can select or deselect the data for backup, using the check boxes. 
 
For this, from the menu bar, go to File and select Automatic Selection option. From the 
‘Automatic Selection’ screen, add/remove the applications and file types using the check boxes 
provided or click Reset button to change the selection. You can modify the selection by clearing 
the checkboxes. 
 
An Automatic Selection entry is displayed in the ‘Contents of my Backup set’ pane. 
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Note: 
• The check boxes are enabled for the applications available on the local computer. 
• The check boxes for file types appearing after Lotus Notes are always enabled for selection irrespective 

of their availability on the local machine. 
• You can also modify the files that you have selected for Automatic Selection by double-clicking the 

Automatic Selection entry displayed in the ‘Contents of my Backup set pane’. 
 
• Connect  
This option lets you connect to the IDrive application.  
 
To use it, from the menu bar, go to File and select the Connect option. A 'Login' screen is 
displayed. Here, enter the Username and Password and click the Connect button to login. 
 
• Disconnect 
This option lets you disconnect from your IDrive application. 
 
To use it, from the menu bar, go to File and select the Disconnect option. Next, click Yes on the 
confirmation screen to disconnect from the application. 
 
• Exit 
This option lets you close the IDrive Classic application. 
 
To use it, from the menu bar, go to File and select the Exit option or click the Close button on the 
main screen. 
 
Note: The scheduled backup operation continues even after you exit from the Classic interface. 
 
Bandwidth Test 
 
The Bandwidth Test menu has options that let you test the upload and download speed. These 
include: 
 
• Upload Speed 
This option lets you know the amount of data that can be uploaded per second and the time it will 
take to backup 1 GB of data to your IDrive account at this speed. 
 
• Download Speed 
This option lets you know the amount of data that can be downloaded per second and how much 
time it will take to restore 1 GB of data to your IDrive account at this speed. 
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Tools 
 
The Tools menu has options that let you access IDrive Explorer interface, customize the default 
settings of your application, exclude files/folders from the Backup set and so on. These include: 
 
• Open IDrive Explorer 
This option allows you to launch the IDrive Explorer interface directly from IDrive Classic 
interface. 
 
• Preferences 
This option lets you take open file backups, exclude files/folders from backup, adjust the 
bandwidth usage of the application and so on.  
 
• Mapped Drive Setup 
This option lets you backup the files/folders present on your network drive.  
 
Activity Log 
 
The Activity Log menu opens the ‘Session Log’ screen that lets you view the log details of all the 
interactive backup/restore and scheduled backup jobs performed in a session.  
  
Help 
 
The Help menu has options that let you access the IDrive help manual, contact technical support 
team for queries/feedback, view product demo, access the IDrive website and so on. These 
include: 
 
• Help Topics 
This option allows you to access the IDrive help manual. 

 
• Send Error Report 
This option allows you to contact the IDrive technical support team in case you confront a 
problem while using the application. 
 
• Quick Demo 
This option allows you to view a demo of IDrive application. 
 
• Website 
This option lets you access the IDrive website. 
 
• About IDrive 
This option displays information on the version and release date of the IDrive application installed 
on your computer. 
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• Check for Updates 
This options lets you upgrade to the latest version of the IDrive application. 
 
• Upgrade Account 
This option takes you to the corresponding IDrive web page from where you can upgrade your 
account. 
 
Toolbar Options 
 
The Toolbar has the following options: 
 
This option lets you schedule the backup of files/folders for a future date and time. It is enabled 
only on the Backup tab.  
 
Sync 
This lets you synchronize the data present in your IDrive account with that on your local 
computer.  
 
Search 
This option lets you locate files backed up to your IDrive account.  
 
Delete 
This option lets you delete the selected files/folder from your IDrive account.  
 
Refresh 
This option updates the content to display as latest. 
 
Timeline Restore 
It displays all the data backed up till the selected date and time. You can select and restore any 
file/ folder. 
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Other Options 
 
The IDrive Classic interface has the following additional options 
 

Icons/ Buttons Description 

 
 

Backup Now 
This option lets you perform an immediate 
backup of files/folders. It is available on the 
Backup tab. 

 
 

Schedule Backup 
This option lets you schedule the backup of 
files/folders for a future date and time. It is 
available on the Backup tab. 

 
 

Restore Now 
This option lets you immediately restore the 
backed up files/folders. It is available on the 
Restore tab. 

 
 

Enable Continuous Backup 
This option allows the IDrive application to 
automatically recognize and perform 
backups of files/folders that have recently 
been updated; in real-time. It is available on 
the Backup tab. 

 
 

Recalculate  
This option lets you know the amount of 
space used in your IDrive account. 

 
 

Upgrade Account 
This option takes you to the corresponding 
IDrive web page from where you can 
upgrade your account. 

 
 

Reduce Storage 
Bring your storage in line with the available 
space by either removing the unwanted files 
from your account or choose Sync to match 
the data between your IDrive account and 
PC. 

 
 

Search  
This option helps you locate files backed up 
to your IDrive account. 

 
 

Timeline Restore  
View and restore data as of a particular 
timeline to your local machine. 
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Working with IDrive Classic 
 
You can perform the following functions using the IDrive Classic interface: 
 
Backup files and folders  
 
You can backup files/folders in the following ways: 
• Backup Now  
 
Steps to take an immediate backup of files/folders using the Backup Now button: 
 
1. Login to the application. 
2. Open the Backup tab. 
3. Select the files/folders to be backed up from the Backup pane. 
4. Click the Backup Now button. The application starts the backup.  
5. You may opt to view the logs on completion of the job. 
 
• Using the right-click mouse option 
 
Steps to backup files/folders using the Windows Explorer: 
 
1. Open the Windows explorer. 
2. Right-click the file/folder to be backed up and from the menu, go to IDrive > Backup this 

file/folder now option, to start the backup, as shown below. 
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Using IDrive Tray Icon 
 
The IDrive Tray Icon allows you to perform an immediate backup of the scheduled job without 
logging into the application. 
 
For this, right-click the IDrive Tray Icon and select the Backup Now option. This starts an 
immediate backup of the previously created Backup set. 
 
Note: Ensure that you have logged into the application at least once before using this option. To access the 
General tab, from the menu bar, go to Tools > Preferences.  
 
Backup Multiple Computers 
 
To backup multiple computers to a single IDrive account or to backup more than 150 GB of data, 
sign up and setup the IDrive desktop application with the same account credentials for up to five 
computers. You have a total storage space of 500 GB to backup. 
 
The plan lets you backup 500 GB of data to this single account with no restrictions of data backed 
up from each computer. 
 
Steps: 
 
1. Sign up for this plan or upgrade to it from the regular IDrive Plan.  
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2. Backup data from each of the computers to your account.   
 

 
 
Restore data from the Family Pack account  
 
Using IDrive desktop application  
 
Select the folder name from which you wish to retrieve your files/folders and click the 'Restore 
Now' button on the 'Restore Tab' of the application.  
 
Using the 'Timeline Restore' option on the application tool bar, you can restore your Backup 
set(s) till a particular date and time, from any of the backed up machines. Data backed up till the 
chosen date and time on the selected machine is displayed on the 'Restore' tab under 'My IDrive'. 
(under machine name). You can select the files and folders that you wish to restore to your local 
computer. 
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Via the web 
 
Login to your account via the web. Data from each of the PCs is displayed under the respective 
folder name with the PC name as top-level identifier in the file / folder hierarchy, making restore 
easy. 
 
Sync data  
 
You can sync data between your Family Pack account and your respective PC. However, you 
can only sync data between the local machine and the corresponding folder in your 'Family Pack' 
account corresponding to the same PC name/identified on your Family Pack account with the PC 
name. 
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Preferences  
 
It has the General Tab and the Exclude Tab.  
 
The General tab has the following options: 
 

 
 
Bandwidth Throttle  
 
The Bandwidth Throttle feature helps optimize the bandwidth consumption so that your backups 
can take place uninterrupted and without hindrance to other applications. You can set separate 
bandwidths for the backups when the system is in use and when it is not. 
 
Bandwidth Throttle (when system is not in use): This option lets you set the bandwidth to be 
used by your system for backups, when it is not in use. By default, it is set to 100%. 
 
Note: The percentage set for Bandwidth Throttle is applicable for both scheduled and interactive backups. 
 
Auto Pause: Select the 'Auto-Pause' option from the check box to use this option. 
 
Auto-Pause option makes intelligent guesses on pausing and resuming backup to enable 
optimum desktop experience during user activity. 
 
 



 

Copyright © Pro Softnet Corporation. All Rights Reserved.                                                                                                 22 

 
This option lets you set the bandwidth to be used by your system for backups, when it is in use. 
This allows other applications to run without hindrance. By default, it is set to 25%. 
 
Restore Destination 
This option prompts you to select the destination folder to which you want to restore your data.  
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Open file Backup 
This option allows you to backup open files like Outlook files (.pst), QuickBooks, Quicken, ACT, 
MS-Money, MS-Word, MS-Excel, MS-Access, MS FoxPro etc.  
 
This feature is available only for Windows XP, Windows 2003 Server, Windows 2008 Server 
Windows Vista and Windows 7 operating systems.  
 
Advanced scheduling options 
  
• Prompt to view log after each backup and restore operation  
This option enables you to view the log files on completion of every backup/restore operation. 

 
• Alert me if the scheduled backup fails 
 On selecting this option, you receive a desktop alert in case your backup has not taken place.  

 
• Automatic power off after scheduled backup 
 This option shuts down the computer automatically on completion of the scheduled backup job. 
 
• Wake up the computer from the Hibernate/Sleep mode 
 If you select this option, IDrive puts your computer in to active mode in case it has gone into the 
Hibernate/Sleep mode and performs the scheduled backup. 
 
• Automatic Sync 
This will sync files between your desktop and your IDrive account with a lag of 30-days 
(applicable only for scheduled backups). In other words, if data is deleted from your desktop that 
was backed up previously, the corresponding data on your IDrive account would be deleted after 
30-days. This helps in keeping your account size at optimal. As a precautionary measure, in case 
the files to be deleted are greater than 5% of the total account content, you would have to run a 
manual sync. * 
 
Note: Since this may result in automatic deletion of data from your IDrive account, use/set this option 
carefully. 
 
* The percentage mention refers to files considered for deletion in your account as a percentage of total 
number of files. The purpose of this percentage-based control is to avoid large deletion of files in your 
account due to some unforeseen event on your PC. 
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Exclude files and folders 
 
The Exclude files/folders option allows you to exclude files/folders from being backed up. For 
this, on the menu bar, go to Tools > Preferences and open the Exclude files/folders tab, as 
shown below. 
 

 
 
The excluded folders are marked in Red color on the 'Backup’ pane. 
The Exclude files/folders tab has the following options: 
 
Exclude files/folders based on full path name with two sub options – Folders with full path name 
and Files with full path name.   
 
You can add the files/folders to the exclude list in the following ways: 
 
• Through the Preferences menu option 
 
Steps to exclude a file/folder from being backed up: 

 
1. Right click on the Folders with full path name or Files with full path name pane. 
2. Select the Add option from the drop down menu. 
3. Select the directory/folder/file from your local computer to be excluded from the Backup set 

and click OK. 
4. Click Save to commit the changes and close the screen.  
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• Through IDrive Classic Interface 

 
Steps to exclude files/folders from Backup set: 

 
1. Right-click the file/folder on the Backup pane. 
2. Select the Exclude this file from being a part of the backup list/Exclude this folder from 

being a part of the backup list option to exclude the selected file/folder from the Backup 
set. 

 
Exclude files/folders based on partial name with two sub options – Folders with full/part 
name or Files with full/part name 
You can exclude files/folders by giving partial name along with wildcard characters (*,?).  
 
Steps to exclude data from backup: 
 
1. Right click the Files with part/full name or Folders with part/full name pane. 
2. Select the Add option from the drop down menu. The ‘Enter File/Folder Name’ screen is 

displayed. 
3. Enter the partial name of the file/folder using the wildcard characters -- * and ? that you want 

to exclude and click Exclude.  
4. Click Save to commit the changes and close the screen. 
 
Note: 
• The ‘?’ replaces a single character in the file name. 
• The ‘*’ replaces one or more/number of character(s) in the file name. 
• To remove the files/folders from the Exclude Files and Folders tab, right-click the required folders/files 

and select the Remove option. 
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Steps to exclude files/folders from the main window: 
 
1. On the main window of the IDrive application, select a file / folder from your Backup list. 
2. Right click on the folder you wish to exclude and click on 'Remove this folder from exclusion'. 
3. View the excluded files/folders from the 'Contents of my Backup set' pane. Right click on the 

file/folder and click on 'View Exclusions'. 
4. The 'Excluded files/folders list' window is displayed. Right click to remove files/folders from 

exclusion. 
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Bandwidth Test 
 
The Bandwidth Test option lets you know the current upload/download speed and the estimated 
time that would be required by application to backup /restore 1 GB of data at this speed. 
 
Upload Speed 
 
Steps to test the current upload speed: 
 
1. Login to the application. 
2. From the menu bar, go to Bandwidth Test and select the Upload Speed option.  

 
A screen showing the current upload speed and estimated time that would be required by the 
application to backup 1 GB data at this speed to your IDrive account is displayed. 
 
Download Speed 
 
Follow the steps given below to test the current download speed: 
 
1. Login to the application. 
2. From the menu bar, go to Bandwidth Test and select the Download Speed option.  

 
A screen showing the current download speed and estimated time that would be required by the 
application to restore 1 GB data at this speed to your IDrive account is displayed. 
 



 

Copyright © Pro Softnet Corporation. All Rights Reserved.                                                                                                 28 

 
Schedule Backups 
 
The Schedule Backup option allows you to schedule the backup of files/folders for a particular 
date, time and frequency.  
 
Steps to schedule backups: 
 
1. Login to the application and click the Backup tab. 
2. Click the Schedule Backup button.  
 
The ‘Scheduler‘ screen is displayed, as shown below. 
 

 
 
3. Select the date, time, frequency and other options for backup as per your convenience and 

click the Close button. The application backs up of the selected files/folders at the scheduled 
time. 

 
The options available to set date, time and frequency of backup are: 
 
Week-Day 
Schedule backup on any day(s) of the week.  
 
Month 
Schedule the backup any one day of the month on a particular day and time.  
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Start the backup immediately 
This option lets you to perform an immediate backup of your files/folders.  
 
No Backup Schedule 
This option lets you delete the scheduled backup job. 
 
Email Notification 
This option allows you to receive email notifications on the status of the scheduled backup jobs. 
For this, select the Notify always or Notify on failure option and enter the email address in the 
Mail to field. 
 
You can set multiple email addresses using the + button and receive log details of the scheduled 
backup job along with the email notification by selecting the Send log extract option. 
 
You may opt to not receive any notification by selecting the Do not notify option. 
 
Minor Tweaks 
 
Auto-Pause  
This option makes intelligent guesses on pausing and resuming backup to enable optimum 
desktop appearances during user activity. 
 
Desktop Notification 
This option allows you to receive notifications on your desktop regarding the status of scheduled 
backup jobs. For this, select the option Show desktop notification on the completion of scheduled 
backup. 
 
Start the missed scheduled backup when the computer is turned on 
This option allows the application to resume the scheduled backup automatically whenever your 
computer is switched on. 
 
Cut-off Time   
This option stops the scheduled backup at the specific time, set by you. The backup is resumed 
at the next scheduled time from the point it was stopped. This ensures that the scheduled 
backups are not executed when the normal computer operations are going-on. 
 
Note: 
• The IDrive application performs scheduled backup job even when your computer is in Log-Off mode. 
• The Send log extract and Mail to options are disabled if the default option - Do not Notify - is selected.  
• The ‘ Under the Hood’ button opens the ‘Preferences’ screen from where you can set the Advanced 

options including Hibernate / Sleep mode settings, Open File Backup, Auto-Pause and more. 
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Search Files 
 
The application allows you to search for files present in your IDrive account and restore them to 
your local machine. 
 
To use the option, follow the steps given below: 
 
1. Login to the application. 
2. Click the Search toolbar option or enter the part/full file name in the Search Files to restore 

field and click the Search icon on the main screen.  
 
The ‘File Search’ screen is displayed, as shown below: 

 
 
3. Enter part/full name of the file to be located and click the Start Search button provided 

alongside. All the files matching the search criteria are displayed. 
4. From the search result, select the desired file and click Restore to restore it to your local 

machine or Delete to delete it from your IDrive account. You can use Select All option to 
select all the listed files. 

 
You can filter the search using the following options: 
• Match the whole file name 
• Picture, Music and Video Files 
• Document Files (.doc and .txt) 
• All Files 
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Delete Files and Folders 
 
You can delete files/folders from your IDrive account. 
 
To use this option, follow the steps given below: 
 
1. Login to the application and open the Restore tab. 
2. Select the files/folders that you want to delete from your IDrive account and click the Delete 

toolbar option. A ‘File Deletion’ screen listing the selected file(s) is displayed. 
3. Click the Delete button to delete the listed file(s) from your IDrive account. 
 
Backup Mapped Drives 
 
This option lets you backup the contents of your Mapped drive to your IDrive account. 
 
For this, follow the steps given below: 
 
1. Open the Windows explorer. 
 
2. Right-click My Computer and select the Map Network Drive option from the menu.  
 
3. Select the network folder that you want to connect to as a Mapped drive, using the Browse 

button.  
 

 
 

4. To connect to the computer with a different Username, click the Connect using a different 
Username link. The following screen is displayed: 
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5. Enter the Username and Password and click OK. You can see a Mapped drive named (ex: 

'Z') in the My Computer entries. The Mapped drive thus created is now available on the IDrive 
application. 

6. Select the files/ folders to be backed up from Backup pane. 
7. From the menu bar, go to Tools and select the Mapped Drive Setup option.  
 
The ‘Mapped Drive Setup’ screen is displayed, as shown below. 

 

 
 
8. Enter the valid Username and Password for the Mapped drive that you have selected. 
9. Click Save to save the settings and schedule the backup job. 
 
Note: The IDrive application performs scheduled backup of Mapped drives even when your computer is in 
the Log-Off mode. 
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Sync Files and Folders 
 
The Sync feature lets you match the contents of your IDrive account with that of your local 
computer, for the selected folders. This feature is useful especially when you have been taking 
backups regularly and now removed some data from your local computer and wish to do the 
same from your IDrive account. 
 
For this, follow the steps given below: 
1. Login to the application. Select the folder, to be synchronized in your account and click the 

Sync toolbar option. A message explaining the sync operation is displayed. Click  Continue 
to proceed.  
 

The following ‘File Synchronization’ screen listing the files present on your IDrive account but not 
on your computer, are listed. 
  

 
 

2. Click the Sync button to start the operation or ‘Close’ to cancel it. 
 
Send Error Report 
 
The Send Error Report feature lets you send a query to the IDrive technical support team, in 
case you encounter any issue while working with IDrive. In the mail, classify the type of error or 
problem encountered so that we can provide a prompt solution. 
 
Steps to send an error report: 
 
1. Login to the application. 
2. From the menu bar, go to Help and select the Send Error Report option. The ‘Feedback on 

IDrive ’ screen is displayed. 
3. Enter your IDrive Username, email id, contact number, trouble ticket number (if any) and the 

subject line. 
4. Explain your problem or query in detail in the Message text box. Click Submit to send your 

feedback or query to the IDrive technical support team.  
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You will receive an email from the IDrive technical support team containing the Ticket Number for 
your query. You can use this as a reference in case you face the same problem again or find that 
it has not been resolved. For this purpose, in the ‘Feedback on IDrive’ screen, a text box for 
Trouble Ticket No is provided. Here, enter the Ticket Number sent to you from the technical 
support team. 
 
You can do the same from IDrive Tray Icon on the tray bar. 
 
Enable Continuous Backup 
 
The Enable Continuous Backup option allows the IDrive application to automatically recognize 
the changes to files up to 500 MB and back them up in real-time. 
 
The application backs up only the modified portions of the files. It stores each modified file as a 
separate version, thereby allowing you to view and/or restore any of the last 30 versions. Full 
backup is performed for newly created files and files that have not been backed up previously. 
 
Steps to perform the continuous backup:  
 
1. Login to the application and open the Backup tab. 
2. Select the files/folders that you want the application to automatically backup. 
3. Click the Enable Continuous Backup button. 
  
Note: 
• Temporary files, system files and Mapped drives are exempted from the Continuous Data Protection 

operation. 
• The files selected for backup are listed under the ‘Contents of My Backup set pane’. You can view or 

modify these files. 
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Restore Old Versions 
 
You can view the latest 30 versions of any file and restore any previous version. 
 
Steps to restore your file to the local machine: 
 
1. Login to the application. 
2. Click the Restore tab. 
3. Double-click or right-click a file and select the View History option from the drop-down menu.  
4. Select the version that you want to restore and click the Restore button. 
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Timeline Restore 
 
It displays all the data backed up till the selected date and time. You can select and restore any 
file/folder to your local machine. 
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IDrive Explorer Interface  
 
The IDrive Explorer Plug-in offers a Windows Explorer like view of your account for access and 
restore of your backed up data.  
 
You can open the IDrive Explorer interface in the following ways: 
 
• Select Start > Programs > IDrive > IDrive Explorer. 
• Right-click the IDrive Tray Icon and select the Open IDrive Explorer option. 
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Besides the regular Windows Explorer options, the IDrive Explorer has options specific to IDrive. 
 

Name Description 

QuotaDisplay Up-to-date information on the space occupied by folders 
and folders backed up to your account.   

Refresh Refreshes the updates made to files in your account. 
IDrive Search 
 

Locate files in your account, based on its full or partial 
name. 

Classic Scheduler Launch the IDrive Classic interface. 
View Log 
 

View the log files for operations like restore, delete, 
interactive/scheduled backups and so on. 

View Version 
 

View and restore any of the recent 30 versions of a file in 
your account.  

Help 
 Access the IDrive Help Manual. 

Logout 
 Logout from the IDrive application. 
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Restore files and folders 
 
The IDrive Explorer interface makes it easy to restore your files and folders.  
 
You can restore your data in the following ways: 
 
Copy-n-Paste  
 
1. Open the IDrive Explorer interface. 
2. Right-click the file/folder and select the ‘Copy’ option from the menu and paste it to the 

desired location on your PC. 
 
Drag-n-drop  
 
1. Open the IDrive Explorer interface. 
2. Select the file/folder and drag-n-drop the file/folder to its intended destination on your PC.  
3. Select the 'open folder after completion of download' from the check box to open the 

file/folder automatically as soon as it is copied or downloaded. 
 
Restore to a specific destination 
 
1. Open the IDrive Explorer interface. 
2. Right-click the file/folder and select the 'Restore to...' option from the menu. Select the 

location on the PC for restore.  
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View/Restore older versions of files 
 
The IDrive application stores up to 30 versions of each file backed up to your account. You can 
view different versions of a file. This option is only enabled for files. 
 
To view the different versions of the file, follow the steps given below: 
 
1. Open the IDrive Explorer interface. 
2. Open the folder and select the file that you want to restore.  
3. Right-click the file and select the ‘View Versions’ option from the menu. 
Or  
Double-click on the file that you want to restore. Select the ‘View Versions’ option from the IDrive 
Explorer Plug-in menu bar.   
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The ‘File Versions’ screen displays with a list all the versions (up to 30). 
 

 
 
 
Note: The versions are stored on an incremental basis. If the file versions cross 30, the oldest version of the 
file is deleted and the 31st version of the file is backed up as 30th version. 
 
View Properties 
 
To view the property of a file/folder, right-click on it and select the Properties option from the 
menu. The ‘Properties’ screen is displayed with information on the file type, location, size and so 
on. 
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IDrive Tray Menu  
 
On installing the IDrive application, the IDrive Monitor icon is displayed on the system tray of your 
computer. On right-clicking it, a shortcut menu is displayed, with the following options: 
 

 
 
Upgrade Account 
This option takes you to the corresponding web page of the IDrive application from where you 
can upgrade your account.  
 
Login - IDrive Classic Scheduler  
This option opens the IDrive Classic Interface. 
 
Login - IDrive Explorer 
This option opens the IDrive Explorer interface. 
  
Activity Log
This option opens the 'Session Log' screen from where you can view the log details of all the 
backup, restore and other operations performed during the current session. 
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Continuous Backup
This option allows the IDrive application to automatically recognize and perform backups of 
files/folders that have recently been updated; in real time. 
 
The color of the IDrive tray icon toggles between yellow and green to indicate that the Continuous 
Data Protection is in progress. 
 
Stop Scheduled Backup 
This option lets you stop all the scheduled backup jobs.  
 
Disabled Scheduled Backup  
This option lets you disable all the scheduled backup jobs. 
 
Manage all the Scheduled Jobs
This option makes it easy for you to manage the scheduled backup jobs by letting you delete the 
scheduled backup jobs of the expired accounts while retaining the scheduled jobs of the others. 
Further, it allows you to view the scheduled backup jobs of all the users on the computer. 
 
To view and manage all the scheduled job, right-click the IDrive tray icon and select the Manage 
all the Scheduled Jobs option. A Manage all the Scheduled jobs screen is displayed. It has the 
following toolbar items: 
  
Edit: Lets you edit the selected scheduled job. You cannot edit the scheduled job with the status 
‘In Progress’. 
Delete: Deletes the selected scheduled job.  You cannot delete the scheduled job with the status 
‘In Progress’. 
Refresh: Refreshes the scheduled list of records. 
Stop Transfer: Stops the progress of the selected scheduled job. 
  
Backup Now
This option lets you take an immediate backup of your Backup set.
 
Check for Updates 
This options lets you upgrade to the latest version of the IDrive application. 
 
Send Error Report
This option lets you contact IDrive technical support team for queries, suggestions or to provide 
feedback.  
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Help
This option lets you access the IDrive help manual. 
 
Exit
This option lets you close the IDrive tray menu. 
 
Note: The color of the IDrive tray icon changes to green when a scheduled backup operation has been 
successfully completed. The color of the IDrive tray icon toggles between green and yellow when the 
scheduled backup is in progress. If the operation fails, the icon turns red. 
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Uninstall IDrive 
 
Follow the steps given below to remove IDrive completely from the local computer: 
 
1. Go to Start > Programs > IDrive and select Uninstall IDrive. A message to stop all the 

scheduled backup jobs and to confirm the uninstallation is displayed.  
2. Click Yes to continue the uninstallation. 
 
Note: It is not advisable to uninstall the IDrive application using the conventional method of removing an 
application (from Control Panel > Add or Remove Programs). 
 

Version Update 
 
To update IDrive with newer versions, from the IDrive tray menu, click the ' Check for Updates' 
option. A message confirming if you want to update to the latest version is displayed. Click 'Yes' 
to proceed. 
 
If the older version is available, it is automatically uninstalled. You need to restart your computer 
only if you install the IDrive Explorer plug-in. 
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Technical Support 
 
Technical Support 
Pro Softnet Corporation, 
IDrive Division, 
26115 Mureau Road, Suite A, 
Calabasas, CA 91302. 
 
Telephone: 
1-866-748-0555 within USA ext 3 
1-818-251-4245 outside USA ext 3 
Monday - Friday, 6:00 AM to 6:00 PM PST 
 
Fax:  
1-818-878-9208  
 
Email address:  
support@idrive.com  
 
For more information, visit: http://www.idrive.com 

mailto:support@idrive.com
http://www.idrive.com/
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